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This section of the User’s Guide provides instruction on using the Land Use, Land-Use 
Change, and Forestry (LULUCF) module of the State Inventory Tool (SIT), and describes the 
methodology used for estimating greenhouse gas (GHG) emissions and sinks from land use, 
land-use change, and forestry at the state level.  



Module 8 – Land Use, Land-Use Change, and Forestry Module         September 2020 

State Greenhouse Gas Inventory Tool User’s Guide for the Land Use, Land-Use Change, and 
Forestry Module                     1.1 

TABLE OF CONTENTS  

1.1 Getting Started .............................................................................................. 2 

1.2 Module Overview ........................................................................................... 4 

1.2.1 Data Requirements .................................................................................. 5 

1.2.2 Tool Layout ............................................................................................. 5 

1.3 Methodology.................................................................................................. 6 

1.4 Uncertainty ................................................................................................. 24 

1.5 References .................................................................................................. 24 

 



Module 8 – Land Use, Land-Use Change, and Forestry Module         September 2020 

State Greenhouse Gas Inventory Tool User’s Guide for the Land Use, Land-Use Change, and 
Forestry Module                     1.2 

1.1 GETTING STARTED 

The Land Use, Land-Use Change, and Forestry (hereafter, LULUCF) module was first 
developed using Microsoft® Excel 2000.  While the module will operate with older versions 
of Excel, it functions best with Excel 2000 or later.  If you are using Excel 2007 or later, 
instructions for opening the module will vary as outlined in the Excel basics below. Some of 
the Excel basics are outlined in the sections below.  Before you use the LULUCF module, 
make sure your computer meets the system requirements.  In order to install and run the 
LULUCF module, you must have: 

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

 Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  To check this setting, launch Microsoft Excel before opening the 
LULUCF module.  Go to the Tools menu and select “Options...” Click on the “Calculations” 
tab and make sure that the radio button next to “Automatic” is selected, and then click on 
“OK” to close the window.  The security settings (discussed next) can also be adjusted at 
this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu.   

 Microsoft Excel Security 

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security 
set to medium (recommended) or low (not recommended).  To change this setting, launch 
Microsoft Excel before opening the LULUCF module.  Once in Excel, go to the Tools menu, 
click on the Macro sub-menu, and then select “Security” (see Figure 1).  The Security pop-
up box will appear.  Click on the “Security Level” tab and select medium.  When set to high, 
macros are automatically disabled; when set to medium, Excel will give you the choice to 
enable macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros.  Macros must be enabled in order for the LULUCF module to work.  Once 
they are enabled, the module will open to the control worksheet.  A message box will 
appear welcoming the user to the module.  Clicking on the “x” in the upper-right-hand 
corner of the message box will close it. 

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the LULUCF module is initially 
opened. The Security Warning lets the user know that some active content from the 
spreadsheet has been disabled, meaning that Excel has prevented the macros in the 
spreadsheet from functioning.  Because SIT needs macros in order to function properly, the 
user must click the “Options” button in the security message and then select, “Enable this 
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content” in the pop-up box. Enabling the macro content for the SIT in this way only enables 
macros temporarily in Excel but does not change the macro security settings.  Once macros 
are enabled, a message box will appear welcoming the user to module.  Click on the “x” in 
the upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros.  To change the setting, first exit out 
of the LULUCF module and re-launch Microsoft Excel before opening the LULUCF module.  
Next, click on the Microsoft Excel icon in the top left of the screen. Scroll to the bottom of 
the menu and select the “Excel Options” button to the right of the main menu. When the 
Excel Options box appears, select “Trust Center” in left hand menu of the box.  Next, click 
the gray “Trust Center Settings” button.  When the Trust Center options box appears, click 
“Macro Settings” in the left-hand menu and select “Disable all macros with notification.”  
Once the security level has been adjusted, open the Stationary Combustion module and 
enable macros in the manner described in the preceding paragraph. 

 Viewing and Printing Data and Results 

The LULUCF module contains some features to allow users to adjust the screen view and the 
appearance of the worksheets when they are printed.  Once a module has been opened, you 
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom 
percentage or selecting one from the drop-down menu.  In addition, data may not all 
appear on a single screen within each worksheet; if not, you may need to scroll up or down 
to view additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the LULUCF module are printed.  To do so, go to the File menu, and then select “Print 
Preview.”  Click on “Page Break Preview” and drag the blue lines to the desired positions 
(see Figure 2).  To print this view, go to the File menu, and click “Print.”  To return to the 
normal view, go to the File menu, click “Print Preview,” and then click “Normal View.” 

Figure 1. Changing Security Settings 

 
 
 

Figure 2. Adjusting Print Margins 
 

Drag cursor 
to resize page 
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1.2 MODULE OVERVIEW 

This User’s Guide accompanies and explains the LULUCF module of the SIT.  The SIT was 
developed in conjunction with EPA’s Emissions Inventory Improvement Program (EIIP).  
Prior to the development of the SIT, EPA developed the States Workbook for estimating 
greenhouse gas emissions.  In 1998, EPA revisited the States Workbook and expanded it to 
follow the format of EIIP guidance documents for criteria air pollutants.  The result was a 
comprehensive, stepwise approach to estimating greenhouse gas emissions at the state 
level.  This detailed methodology was appreciated by states with the capacity to devote 
considerable time and resources to the development of emission inventories.  For other 
states, the EIIP guidance was overwhelming and impractical for them to follow from scratch.  
EPA recognized the resource constraints facing the states and developed the SIT.  The ten 
modules of the SIT corresponded to the EIIP chapters and attempted to automate the steps 
states would need to take in developing their own emission estimates in a manner that was 
consistent with prevailing national and state guidelines.   

Because most state inventories developed today rely heavily on the tools, User’s Guides 
have been developed for each of the SIT modules.  These User’s Guides contain the most 
up-to-date methodologies that are, for the most part, consistent with the Inventory of U.S. 
Greenhouse Gas Emissions and Sinks.  Volume VIII of the EIIP guidance is a historical 
document that was last updated in August 2004, and while these documents can be a 
valuable reference, they contain outdated emissions factors and, in some cases, outdated 
methodologies.  States can refer to Volume VIII of the EIIP guidance documents if they are 
interested in obtaining additional information not found in the SIT or the companion User’s 
Guide. 

When humans use and alter the biosphere through land-use change and forest management 
activities, the balance between the emission and uptake of greenhouse gases (GHGs) 
changes, affecting their atmospheric concentration; this balance between emission and 
uptake is known as net GHG flux.  Such activities can include clearing an area of forest to 
create cropland, restocking a logged forest, draining a wetland, or allowing a pasture to 
revert to grassland.  Carbon in the form of yard trimmings and food scraps can also be 
sequestered in landfills, as well as in trees in urban areas.  In addition to carbon flux from 
forest management, urban trees, landfills, and agricultural soils (i.e., cropland and 
grassland), other sources of GHGs under the category of land use, land-use change, and 
forestry are emissions of methane (CH4) and nitrous oxide (N2O) from forest fires, and N2O 
emissions from fertilization of settlement soils.   

The LULUCF module calculates CO2, CH4, and N2O emissions from fertilization of settlement 
soils, and forest fires, as well as carbon flux from forest management, urban trees, 
landfilled yard trimmings and food scraps, and agricultural soils. The LULUCF module no 
longer estimates CO2 emissions from Liming of Soils and Urea Fertilization. These categories 
are now estimated in the Agriculture module for consistency with the Inventory of U.S. 
Greenhouse Gas Emissions and Sinks. 

The module provides default data for most inputs; however, if you have access to a more 
comprehensive or state-specific data source, it should be used in place of the default data.  
If using outside data sources, or for a more thorough understanding of the tool, please refer 
to the following discussion for data requirements and methodology. 
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1.2.1 Data Requirements 

To calculate GHG emissions from land use, land-use change, and forestry, the data listed in 
Table 1 are required inputs (again, note that defaults are available for most of these data). 

Table 1. Required data inputs for the LULUCF module. 
Forestry 
Worksheets Input Data Required 
Forest Carbon Flux 
(Forest Land Remaining 
Forest Land, Land 
Converted to Forest 
Land, and Forest Land 
Converted to Land) 

Carbon emitted from or sequestered in aboveground biomass, 
belowground biomass, dead wood, litter, mineral and organic soils, 
drained organic soils, wood products and landfills (million metric tons) 

Urban Trees Carbon sequestration factor for urban trees (metric ton C/hectare/year) 
Total urban area (square kilometers) 
Urban area tree cover (percent) 

N2O from Settlement 
Soils 

Direct N2O emission factor for managed soils (percent) 
Total synthetic fertilizer applied to settlements (metric tons nitrogen) 

Non-CO2 Emissions from 
Forest Fires 

 
 

Emission factors for CH4 and N2O emitted from burning forest and 
savanna (grams of gas/kilogram of dry matter combusted) 
Combustion efficiency of different vegetation types (percent) 
Average biomass density (kilograms dry matter per hectare) 
Area burned (hectares) 

Landfilled Yard 
Trimmings and Food 
Scraps 

 

Grass, leaves, and branches constituting yard trimmings (percent) 
Yard trimmings and foods scraps landfilled, 1960-present (tons) 
Initial carbon content of yard trimmings and food scraps (percent) 
Dry weight/wet weight ratio of yard trimmings and foods scraps (percent) 
Proportion of carbon stored permanently for yard trimmings and foods 
scraps (percent) 
Half-life of degradable carbon for yard trimmings and foods scraps (years) 

Agricultural Soil Carbon 
Flux 

Carbon emitted from or sequestered in mineral and organic soils on 
cropland and grassland (million metric tons) 

 

1.2.2 Tool Layout 

Because there are multiple steps to complete within the LULUCF module, it is important to 
understand of the module’s overall design.  The layout of the LULUCF module and the 
purpose of its worksheets are presented in Figure 3.  
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Figure 3: Flow of Information in the LULUCF Module* 

Control Worksheet
1. Choose a State
2. Enter Forest Carbon Flux Data 2. Forest Carbon Flux

Enter data on annual change in carbon stocks of various forest pools.
2a. Forest Land Remaining Forest Land

Default data pulled from FRF Carbon Flux worksheet.
2b. Land Converted to Forest Land

Default data pulled from LCF Carbon Flux worksheet.
2c. Land Converted to Forest Land

Default data pulled from FCL Carbon Flux worksheet.
3. - 6. 3. Urban Trees

Verify Variables for Each Sector on Control Sheet Enter data on total urban area and percent of urban area with tree cover.
Complete Sector Worksheets 4. N2O from Settlement Soils

Enter data on fertilizer applied to settlement soils.
5a. CH4 Emissions from Forest Fires

Enter data on area of forest and savanna burned, by forest type.
5b. N2O Emissions from Forest Fires

Data pulled from CH4 Emissions from Forest Fires worksheet.
6. Landfilled Yard Trimmings and Food Scraps

Enter data on yard trimmings and food scraps.
7. Enter Agricultural Soil Carbon Flux Data 7. Agricultural Soil Carbon Flux
8. View Summary Data Enter data on annual change in carbon stocks in agricultural soils.
9. Export Data

Presented in both table and graphical formats in MMTCO2E.

Review information on uncertainty associated with default data.

Individual Sector Worksheets

Uncertainty

Summary Data

 
* These worksheets are the primary worksheets used in the LULUCF module; subsequent worksheets 
are used to populate the default data and are provided for informational purposes only. 
 

1.3 METHODOLOGY 

This section provides a guide to using the LULUCF module of the SIT to estimate GHG 
emissions and sequestration from land use, land-use change, and forestry.  Within the 
LULUCF module, there are six sections: forest carbon flux; urban trees; N2O from 
settlement soils; non-CO2 emissions from forest fires; carbon storage in landfilled yard 
trimmings and food scraps; and agricultural soil carbon flux. Because the methodology 
varies considerably among these sources/sinks, the details of each will be discussed in its 
respective step, following this general methodology discussion.   

The LULUCF module will automatically calculate emissions after you enter the factors on the 
control worksheet and the required activity data on the individual sector worksheets.  The 
tool provides default sector data for most sectors.  The exception is forest fires where you 
will have to use an outside data source for area of forest burned per year (see Box 1 for 
suggested data sources). 
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There are nine general steps involved in estimating emissions using the LULUCF module: (1) 
select a state; (2) select an option for forest carbon flux; (3) enter emission factors and 
activity data for urban trees; (4) enter emission factors and activity data for N2O from 
settlement soils; (5) enter emission factors and activity data for non-CO2 emissions from 
forest fires; (6) enter emission factors and activity data for landfilled yard trimmings and 
food scraps; (7) select an option for agricultural soil carbon flux; (8) review summary 
information; and (9) export data.  The general equations used to calculate GHG emissions 
from land use, land-use change, and forestry are provided below. 

Step (1) Select a State  

To begin, select the state you are interested in evaluating.  By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool.  

Step (2) Select an Option for Forest Carbon Flux  

Control Worksheet 

The control worksheet allows you to either select the default data provided or to enter user-
specified data to be used throughout the tool.  To proceed with the default data, select the 
first radio button under step 2 on the control worksheet. Default data are available for three 
land-use categories: Forest Land Remaining Forest Land, Land Converted to Forest Land, 
and Forest Land Converted to Land. These three categories are summed together on the 
Summary tab to calculate Net Forest Carbon Flux. If you would like to use your own state-
specific data, select the second radio button under step 2 of the control worksheet.  See 
Figure 4 for an example of the radio buttons in step 2.     

Box 1: Forest Fire Data Sources 
• Data are available from the National Interagency Coordination Center, which compiles fire 

records from Situation and Incident Status Summary (ICS-209) Reports.  These records 
provide the number of acres burned by forest fire by state, and can be found in Table 12.4-2 of 
the EIIP Guidance or online at https://www.nifc.gov/fireInfo/fireInfo_statistics.html 

• To obtain the most accurate emission estimates, it is necessary to have information on the 
type of forests that have burned, as different types of forests contain differing amounts of 
combustible biomass.  To further refine the analysis, information on specific burns and forest 
types can be found in the U.S. Federal Wildland Fire Management’s website: 
http://www.fs.fed.us/fire/.   

• To obtain accurate emissions for both wildfires and prescribed burning, users may directly 
consult FOFEM, which is available for download at https://www.firelab.org/project/fofem. 
Additional instructions for using the model are provided on the website.  

• Land management agencies (e.g., the U.S. Forest Service, Bureau of Land Management, State 
Natural Resource Divisions) in each state maintain statistics on the areas and types of forests 
within their jurisdiction that have burned.  

• State-level estimates of non-CO2 emissions from forest fires are available for certain states 
from the U.S. Forest Service's publication, "Greenhouse gas emissions and removals from 
forest land, woodlands, and urban trees in the United States, 1990-2018" (see Appendix 1 of 
the publication). 

https://www.nrs.fs.fed.us/pubs/59852
https://www.nrs.fs.fed.us/pubs/59852
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Figure 4. Control Worksheet for the LULUCF Module 
 

 

As a result of biological processes (e.g., growth and mortality) and anthropogenic activities 
(e.g., harvesting, thinning, and other removals), carbon is continuously cycled through 
ecosystem components, as well as between the forest ecosystem and the atmosphere.  For 
example, the growth of trees results in the uptake of carbon from the atmosphere and 
storage in living trees.  As these trees age, they continue to accumulate carbon until they 
reach maturity, at which point their carbon storage remains relatively constant.  As trees die 
or drop branches and leaves on the forest floor, decay processes will release carbon to the 
atmosphere and also increase soil carbon.  Some carbon from forests is also stored in wood 
products, such as lumber and furniture; and also in landfills, because when wood products 
are disposed of, they do not decay completely, and a portion of the carbon gets stored 
indefinitely, as with landfilled yard trimmings and food scraps.  The net change in forest 
carbon is the change in the amount of carbon stored in each of these pools (i.e., in each 
ecosystem component) over time.  This section presents the methodology for calculating 
forest carbon flux.   

After completing the control worksheet for this sector, use the gray arrows to navigate to 
the Forest Land Remaining Forest Land worksheet. 

Forest Land Remaining Forest Land Worksheet 

Select All Defaults 

Individual Default 
Data Check Boxes 

Choose a State 

Required Data 

Forest Carbon Flux 
Radio Buttons  
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If you are using the default data for forest carbon flux estimates, there is no further 
information to enter.  Figure 5 shows the default worksheet for Forest Land Remaining 
Forest Land.  

Figure 5. Example of Forest Land Remaining Forest Land Worksheet Using Default 
Data  

 

 
 

Next, click the gray navigational arrow to continue to the Land Converted to Forest Land 
worksheet. 

 Land Converted to Forest Land Worksheet 

This tab calculates net sequestration/emissions from Land Converted to Forest Land. This 
category includes Cropland Converted to Forest Land, Grassland Converted to Forest Land, 
Settlements Converted to Forest Land, and Other Land Converted to Forest Land. There is 
no further information to enter on this tab if you are using the default data for forest carbon 
flux. Figure 6 shows the default worksheet for Land Converted to Forest Land. 

On default sheet, data are 
already provided 
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Figure 6: Example of Land Converted to Forest Land Worksheet Using Default Data 

 

Next, click the gray navigational arrow to continue to the Forest Land Converted to Land 
Worksheet. 

 Forest Land Converted to Land Worksheet 

This tab calculates net sequestration/emissions from Forest Land Converted to Land. This 
category includes Forest Land Converted to Cropland and Forest Land Converted to 
Settlements. There is no further information to enter on this tab if you are using the default 
data for forest carbon flux. Figure 7 shows the default worksheet for Forest Land Converted 
to Land. 

Figure 7: Example of Forest Land Converted to Land Worksheet Using Default Data 

 

 

If you are using your own data on forest carbon flux, enter carbon flux data for 
aboveground biomass, belowground biomass, dead wood, litter, mineral and organic soils, 
drained organic soil, and wood products and landfills in the green cells on the C Flux-User 

On default sheet, data are 
already provided 

On default sheet, data are 
already provided 
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Data tab. Figure 8 shows the worksheet where you will enter this forest carbon flux data.  
The method used for calculating forest carbon flux is shown in Equation 1.  The calculation 
is a sum of the fluxes for above- and belowground biomass, dead wood, litter, mineral and 
organic soils, drained organic soil, and wood products in use and in landfills.  Once this 
sector worksheet is complete, use the gray navigational arrow to return to the control 
worksheet and proceed to the next step.    

 
Equation 1.  Forest Carbon Flux Equation 

 

 

Figure 8. Example of User-Entered Data Forest Carbon Flux Worksheet  

 
 

Step (3) Enter Emission Factors and Activity Data for Urban Trees 

Control Worksheet 

On the control worksheet, enter a carbon sequestration factor for urban trees in the 
appropriate yellow cell (metric tons of carbon per hectare per year).  Default state-specific 
estimates of net sequestration are provided from Nowak et al. (2013). If the user-specific 
inputs do not match the default data in the control worksheet (i.e., the default value is 
overwritten), the text will appear red. 

Emissions or Sequestration (MMTCO2E) = 
Sum of carbon fluxes from aboveground biomass, belowground biomass, dead wood, 
litter, mineral and organic soils, drained organic soil, and wood products and landfills 

Enter flux data in green 
cells 
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Trees in urban areas represent approximately 5.5 percent of total United States tree canopy 
cover (Nowak and Greenfield 2012).  Furthermore, because trees in urban areas grow in 
relatively open surroundings, their growth and carbon sequestration are disproportionately 
large relative to forests.  This section presents the methodology for calculating carbon 
sequestered by urban trees in your state.   

After entering the appropriate sequestration factor, use the gray arrows to navigate to the 
Urban Trees worksheet. 

Urban Trees Worksheet 

Within the Urban Trees worksheet, enter data on the total urban area in your state (in 
square kilometers), as well as the average percent of urban area covered by trees, in the 
yellow cells.  An example of this worksheet is shown in Figure 9.  Equation 2 shows the 
method used to calculate carbon sequestration in urban trees.   

Default urban areas are taken from Nowak et al. (2005) and the U.S. Census (1990, 2002, 
and 2012). Default state-specific percentages of urban tree cover are taken from Nowak 
and Greenfield (2012). Once this worksheet is complete, use the gray navigational arrow to 
return to the control worksheet and proceed to the next step.  
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Equation 2.  Urban Trees Equation 

 

Figure 9. Example of Carbon Sequestration Factor Applied in the Urban Trees 
Worksheet 

 

 

Step (4) Enter Emission Factors and Activity Data for N2O from Settlement 
Soils 

Control Worksheet 

Of the fertilizers applied to soils in the United States, approximately 10 percent are applied 
to lawns, golf courses, and other landscaping occurring within settled areas.  This section of 
the LULUCF module estimates N2O emissions due to the application of fertilizers to 
settlement soils.  On the control sheet you must enter an emission factor that will be used 
to calculate direct emissions due to fertilizer applications.  The default value of 1 percent 
comes from IPCC (2006). If the user-specific inputs do not match the default data in the 
control worksheet (i.e., the default value is overwritten), the text will appear red. 

After entering the appropriate emission factor, use the gray arrows to navigate to the Non-
CO2 from Settlement soils worksheet.  

Sequestration (MMTCO2E) = 
Total Urban Area (km2) × Urban Area with Tree Cover (%) 

× 100 (ha/km2) × C Sequestration Factor (metric tons C/ha/yr) × 44/12 (ratio of CO2 to 
C) ÷ 1,000,000 (to yield MMTCO2E) 

Carbon 
Sequestration Factor 
(from Control) 

Required Data on Urban 
Area and Tree Cover 
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N2O from Settlement Soils Worksheet 

To complete this worksheet enter the amount of synthetic fertilizer applied (in metric tons of 
nitrogen) in the light blue cells (Figure 10).  Emissions are calculated by multiplying the 
fertilizer data by the emission factor for direct emissions of N2O (1.0 percent) to obtain the 
amount of emissions in N2O-N/yr.  This number is then converted from MT N2O-N to MT 
N2O by multiplying by the ratio of N2O/N2O-N (44/28).  This is then converted to MMTCO2E 
by dividing by 1,000,000 and multiplying by the GWP of N2O.  This calculation is shown in 
Equation 3.  Once this worksheet is complete, use the gray navigational arrow to return to 
the control worksheet and proceed to emissions from forest fires.    

Figure 10. Example of Fertilizer Data Applied in the Settlement Soils Worksheet 
 

 

Equation 3.  Equation for Direct N2O Emissions from Settlement Soils 

 

Step (5) Enter Emission Factors and Activity Data for Non-CO2 from Forest 
Fires 

Control Worksheet 

On the control worksheet, the following data must be entered in the appropriate yellow cells 
for forest fires:  (1) emission factors for N2O and CH4 for forest and savanna (grams of gas 
per kg dry matter combusted), (2) combustion efficiency by vegetation type (%), and (3) 

Emissions (MMTCO2E) = 
Total Synthetic Fertilizer Applied to Settlement Soils (metric ton N) × 
Emission Factor (percent) × 0.01 (metric tons N2O-N/metric ton N) × 

44/28 (Ratio of N2O to N2O-N) × 298 (GWP) ÷ 1,000,000 
(MT/MMTCO2E) 

Emission Factor 
(from Control) 

Required data on 
applied fertilizer 
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average biomass density in the state (kg dry matter per hectare).  Default emission factors 
and combustion efficiencies are from IPCC (2006).  Default biomass densities are adapted 
from Smith et al. (2001) and U.S. EPA (2003).  States are encouraged to use this more 
detailed data if it is available and well documented. If the user-specific inputs do not match 
the default data in the control worksheet (i.e., the default value is overwritten), the text will 
appear red. 

When a forest (or savanna) burns, the CO2 emissions are included in the overall flux of 
forest carbon that is calculated in the forest carbon flux worksheet.  However, forest fires 
also cause emissions of N2O and CH4 that are not accounted for under forest carbon flux 
because they are non-CO2 emissions.  This section presents the methodology for calculating 
N2O and CH4 emissions from forest fires.   

After entering the appropriate emission factors for forest fires, use the gray arrows to 
navigate to the Non-CO2 from Forest Fires worksheet. 

Non-CO2 from Forest Fires Worksheets 

Within the Forest Fires worksheet, enter the area (hectares) burned per year in the pink 
cells.  Because there is no default data available on area burned by state, you must rely on 
outside sources for this information (see Box 1 for suggestions). Equation 4 shows the 
method used to calculate N2O and CH4 emissions from forest fires.  An example of this 
worksheet is shown in Figure 11.  Once this sector worksheet is complete, use the gray 
navigational arrow to return to the control worksheet and proceed to the next category.    

Equation 4.  Forest Fires Emissions Equation 
 

 

Emissions (MMTCO2E) = 
Area Burned (ha) × Average Biomass Density (kg dry matter/ha) × Combustion 

Efficiency (%) × Emission Factor (g gas/kg dry matter burned) × GWP 
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Figure 11. Example of Forest Fire Data Applied in the Forest Fire Worksheet 
 

 

Step (6) Enter Emission Factors and Activity Data for Landfilled Yard 
Trimmings and Food Scraps  

Control Worksheet 

When wastes of biogenic origin (such as yard trimming and food scraps) are landfilled and 
do not completely decompose, the carbon that remains is effectively removed from the 
global carbon cycle.  This section of the LULUCF module estimates the carbon stored in 
landfills by yard trimmings and food scraps.  

Because the Landfilled Yard Trimmings and Food Scraps sector involves complicated 
calculations, the gray navigational arrow on the control worksheet takes you directly to the 
Landfilled Yard Trimmings and Food Scraps worksheet.   

Landfilled Yard Trimmings and Food Scraps Worksheet 

The Landfilled Yard Trimmings and Food Scraps sector worksheet calculates net carbon flux 
by estimating the change in landfilled carbon stocks between years, based on 
methodologies presented in IPCC (2003) and IPCC (2006).  The LULUCF module uses 
Equation 5 to calculate carbon sequestration associated with landfilled yard trimmings and 
food scraps.  Carbon stock estimates were calculated by: determining the mass of landfilled 
carbon resulting from yard trimmings or food scraps discarded in a given year; adding the 
accumulated landfilled carbon from previous years; and subtracting the portion of carbon 
landfilled in previous years that has decomposed.  

Combustion 
Efficiencies 
(from Control) 

Biomass Density 
(from Control) 

Emission Factors 
(from Control) 

Required data 
on area burned 
by forest fires 
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Equation 5. Landfilled Yard Trimmings and Food Scraps Equation 
 

 

To determine the total landfilled carbon stocks for a given year, the tool employs: (1) the 
composition of the yard trimmings; (2) the mass of yard trimmings and food scraps 
discarded in landfills; (3) the carbon storage factor of the landfilled yard trimmings and food 
scraps adjusted by mass balance; and (4) the rate of decomposition of the degradable 
carbon.   

Due to the number of factors involved, the Landfilled Yard Trimmings and Food Scraps 
sector worksheet is arranged by a series of steps.  To complete this sector worksheet, follow 
the steps below.   

1. Enter the amount of landfilled yard trimmings and food scraps. 

a. Enter the composition of yard trimmings in the orange cells as a percent of 
grass, leaves, and branches.   Default percentages are available by clicking on 
the check boxes to the right of the orange input cells and are provided by 
Oshins and Block (2000).  Figure 12 displays the inputs cells where this 
information is entered. If the user-specific inputs do not match the default 
data in the worksheet (i.e., the default value is overwritten), the text will 
appear red. 

b. Enter the total annual landfilled yard trimmings and food scraps from 1960 to 
the present in short tons of wet weight in the yellow input cells.  Default data 
are provided by clicking on the gray “Use default yard trimmings data” button 
above the yellow input cells.  The tool uses the percentage entered for yard 
trimmings in the previous step to allocate the amount of yard trimmings 
distributed among grass, leaves, and branches.  The default data from U.S. 
EPA (2019) is a national total for yard trimmings and food scraps and is 
distributed to each state based on state population. 

LFC i,t =  Σ Wi,n × (1 - MCi) × ICCi  × {[CSi × ICCi] + [(1 – (CSi × ICCi )) × e-k× (t - n) ]} 
                     n 

where, 
t   = the year for which carbon stocks are being estimated,  
LFC i,t  = the stock of carbon in landfills in year t, for waste i (grass, leaves, 

branches, food scraps) 
Wi,n   = the mass of waste i disposed in landfills in year n, in units of wet 

weight 
n   = the year in which the waste was disposed, where 1960 < n < t 
MCi   = moisture content of waste i, 
CSi   = the proportion of initial carbon that is stored for waste i, 
ICCi  = the initial carbon content of waste i, 
e   = the natural logarithm, and 
k   = the first order rate constant for waste i, and is equal to 0.693 divided 

by the half-life for decomposition. 
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Figure 12. Landfilled Yard Trimmings and Food Scraps Worksheet, Step 1 
 

 

2. Calculate the amount of carbon added to landfills annually. 

a. Enter the initial carbon content percent for grass, leaves, branches, and food 
scraps in the orange cells, as shown in Figure 13.  The default percentages 
are taken from Barlaz (1998). If the user-specific inputs do not match the 
default data in the worksheet (i.e., the default value is overwritten), the text 
will appear red. 

b. Enter the dry weight to wet weight ratio for grass, leaves, branches, and food 
scraps, also shown in Figure 13.  This default information is drawn from 
Tchobanoglous, et al. (1993). If the user-specific inputs do not match the 
default data in the worksheet (i.e., the default value is overwritten), the text 
will appear red. 

Percent grass, leaves, 
and branches in yard 
trimmings 

Total landfilled yard 
trimmings and food 
scraps, 1960 to present 
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Figure 13. Landfilled Yard Trimmings and Food Scraps Worksheet, Step 2 
 

 

3. Calculate the total annual stocks of landfilled carbon. 

a. In the orange input cells, enter the proportion of carbon from each material 
stored in landfills indefinitely, as shown in Figure 14.  Or use the default 
proportions, based on Barlaz (1998, 2005, and 2008). If the user-specific 
inputs do not match the default data in the worksheet (i.e., the default value 
is overwritten), the text will appear red. 

b. Enter the half-life of the degradable carbon in each of the materials in years, 
shown in Figure 14.  The default data are from IPCC (2006). If the user-
specific inputs do not match the default data in the worksheet (i.e., the 
default value is overwritten), the text will appear red. 

Once this sector worksheet is complete, use the gray navigational arrow to return to the 
control worksheet.    

Enter initial carbon 
contents. 

Enter dry weight to wet 
weight ratio. 
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Figure 14. Landfilled Yard Trimmings and Food Scraps Worksheet, Step 3 
 

 

 

Step (7) Select an Option for Agricultural Soil Carbon Flux  

Control Worksheet 

The control worksheet allows you to either select the default data provided or to enter user-
specified data to be used throughout the tool.  To proceed with the default data, select the 
first radio button under step 7 on the control worksheet.  If you would like to use your own 
state-specific data, select the second radio button under step 7 of the control worksheet.  
See Figure 15 for an example of the radio buttons in step 7.     

Enter proportion of carbon 
stored permanently 

Enter half-life of 
degradable carbon 
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Figure 15. Control Worksheet for the LULUCF Module 
 

 

Carbon is continuously cycled through the cropland and grassland ecosystems and the 
atmosphere.  The amount of carbon stored in cropland varies according to crop type, 
management practices (e.g., rotation, tillage, drainage), and soil and climate variables.  The 
amount of carbon stored in grassland depends on management practices (e.g., irrigation) 
and is also impacted by inter-annual climate variability, such as increased rainfall (IPCC 
2006).  Soil is the primary carbon pool in both cropland and grassland (U.S. EPA 2020).  

The net change in agricultural soil carbon is the change in the amount of carbon stored 
primarily in mineral and organic soils over time.  This section presents the methodology for 
calculating agricultural soil carbon flux.  

After completing the control worksheet for this sector, use the gray arrows to navigate to 
the Agricultural Soil Carbon Flux worksheet. 

Agricultural Soil Carbon Flux Worksheet 

If you are using the default data for agricultural soil carbon flux estimates, there is no 
further information to enter.  Figure 16 shows the default agricultural soil carbon worksheet.  

Agricultural Soil 
Carbon Flux Radio 

Buttons  
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Figure 16. Example of Agricultural Soil Carbon Flux Worksheet Using Default Data  
 

 
 

If you are using your own data on agricultural soil carbon flux, in the red cells enter total 
carbon flux data for cropland and grasslands (including land recently converted to cropland 
and grassland). Figure 17 shows the worksheet where you will enter agricultural soil carbon 
flux data.  Once this sector worksheet is complete, use the gray navigational arrow to return 
to the control worksheet and proceed to the next step.    

 
Figure 17. Example of User-Entered Data Agricultural Soil Carbon Flux Worksheet 

 
 

Enter flux data in red cells 

On default sheet, data are 
already provided 
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Step (8) Review Summary Information 

The steps above provide estimates of total emissions and sequestration from land use, land-
use change, and forestry activities.  The information from each sector worksheet is collected 
on the summary worksheet, which displays results in MMTCO2E.  Figure 18 shows the 
summary worksheet that sums the emissions and sinks from all components of the LULUCF 
module.  In addition, the results are displayed in graphical format at the bottom of the 
summary worksheets. Depending on whether the user entered their own data for forest 
carbon flux or used the default data provided by the module, additional rows may be shown 
to summarize emissions totals from Forest Land Remaining Forest Land, Land Converted to 
Forest Land, and Forest Land Converted to Land. 

Figure 18. Example of the Emissions Summary Worksheet in the LULUCF Module 

 
 

Step (9) Export Data 

The final step is to export the summary data.  Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
GHG inventory for the state. 

To access the “Export Data” button, return 
to the control worksheet and scroll down to 
the bottom (9).  Click on the “Export Data” 
button and a message box will open that 
reminds the user to make sure all steps of 
the module have been completed.  If you 
make any changes to the LULUCF module 
later, you will then need to re-export the 
results. 

Note: the resulting export file should not be 
modified.  The export file contains a summary 
worksheet that allows users to view the results, as well as 
a separate data worksheet with an unformatted version of 
the results.  The second worksheet, the data worksheet, 
contains the information that is exported to the Synthesis 
Tool.  Users may not modify that worksheet.  
Adding/removing rows, moving data, or making other 
modifications jeopardize the ability of the Synthesis 
Module to accurately analyze the data.   
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Clicking “OK” prompts you to save the file.  The file is already named, so you only need to 
choose a convenient place to save the file.  After the file is saved, a message box will 
appear indicating that the data was successfully exported.   

While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 

Following data export, the module may be reset and run for an additional state.  
Alternatively, you may run the remaining modules of the SIT to obtain a comprehensive 
profile of emissions for your state.  

 
1.4 UNCERTAINTY 

In the upper right-hand corner of the summary worksheet is a button: “Review discussion of 
uncertainty associated with these results.”  By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 
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